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About this Document
This document was created on a Macintosh computer with Netscape Composer, Version 4. The PC
version of Netscape Composer, Version 4, is virtually identical except for minor differences in the
appearance of some dialog boxes and screens. Most menus, buttons, and commands are also
identical on both platforms. In those rare cases when the difference is more significant, there are
specific directions for each platform. It is hoped that this document will help you create your own
Web pages no matter what platform and version you have at your disposal.

About Web Pages & Web Sites
A Web “page” is a single document containing text and graphic images. As a member of the World
Wide Web, you can have a collection of any number of such pages, each a separate document. Such
a collection is usually called a Web “site.” A “home page” is typically the main page that a user first
accesses when viewing your Web site. Some people put everything on one single page, which a user
then has to scroll through to find what he or she is looking for. By putting your different pieces of
information on a collection of separate but related pages, the user has to do much less scrolling, and
you can update individual pages without having to change everything. Think of your Web site as a
book, your home page as its table of contents, and all of your other pages as chapters in the book.
As in a real book, a user can bounce back and forth from the table of contents to its various
chapters. For example, if you were a college professor, you could have a site containing such things
as your current schedule, the syllabi for the courses you are currently teaching, your vita, your
research interests, papers you have presented or published, etc. Your home page would be a simple
listing of these various categories. Then each of your syllabi, for example, could be a separate page
with a link to it from your home page. When the semester is over and you are no longer teaching
that course, rather than removing all of the syllabus’ text, you would simply have to remove the link
on your home page (although the syllabus itself would still exist on KU’s server). In the future when
you once again teach that course, you would merely have to re-establish the link, rather than
entering and uploading the entire syllabus again.

Building a Web Page
in Netscape Composer

Designing and building Web pages has become an industry unto itself. There are companies that
specialize in taking your money and designing your Web pages for you. There are expensive
computer applications (such as PageMill and FrontPage) dedicated to creating Web pages. Some
equally-expensive word processors (such as Microsoft Word) allow you to convert a standard
document into a Web page, provided that you followed very specific conventions in creating your
document in the first place. All of these methods for creating Web pages are probably far more
sophisticated than what you—the average, beginning user—need to get started in designing and
building a simple home page.

Fortunately, Netscape Communicator itself has the built-in capability for creating Web pages with a
surprising amount of sophistication. It is relatively easy to use, and the best part is that it costs you
nothing extra (since Netscape Communicator is now free to all users). It is also available on
virtually every computer on campus that is connected to the Internet, making it an easily-accessible
Web page creation tool.
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Getting Started
To create a new, blank document, pull down the “File” menu
to “New,” and select “Blank Page” from the resulting
submenu. You will be greeted by a blank window with a
solid-colored background in the default color (probably
gray).

Toolbars
There are two toolbars for making page creation easier. To show or hide each of these toolbars, click
on the arrowed tab at the left end of the toolbar. Nearly all of the commands and operations that
are available on these toolbars are also available directly from menus (so if you have a small screen,
you might want to hide these toolbars and use the menus instead).

File/Insert Toolbar

NEW: Since your Web site will probably consist of several individual pages, use this button
to create another new page.

OPEN FILE: If you need to open a page that you previously created, use this button.

SAVE FILE: To quickly save your page to disk, click on this button.

PUBLISH: Use this button when you are all finished creating your document, and you want
to upload it to the server. Since this step is at the heart of making your page accessible to the
rest of the world, a subsequent section of this document is devoted to its function.

VIEW IN NAVIGATOR: Use this button to switch from the Editor (the window you are in
when you create a new document) to the Browser (the window you and everyone else will
actually see when they access your page on the World Wide Web).

CUT: When you want to remove an item from its current location on the page so that you
can place it somewhere else on the page, use this button. Cutting deletes the item from its
current location, but saves a copy of it on the Clipboard.

COPY: This is the button to use when you want to save a copy of the selected item to the
Clipboard. The selected item is left unchanged.

PASTE: After you have cut or copied an item, use this button the paste the item on the page.
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Format Toolbar

Although the World Wide Web has become very graphically-oriented with browsers such as
Netscape Navigator and Internet Explorer, the simple truth is that text still dominates and drives
most Web pages. Much of what you may want to include on your personal Web pages will probably
be text-based as well. Consequently, understanding how browsers handle text and how you have to
enter and edit text is vital for having a successfully-designed Web page. Although the name of each
button pops up as you move the cursor over it, thereby making its use fairly obvious, more complete
descriptions are included below.

In order to understand paragraph formatting, it is essential to understand how fonts are handled in
Netscape Navigator (or any other browser for that matter). You may have already noticed that
there were no provisions for changing the font itself. Since the fonts you have installed on your
computer may not be the same as those installed on another person’s computer, Netscape Navigator
uses one font for all text displayed on a Web page. What that font is and its “normal” size are set by
the user in the “Preferences” (under the “Edit” menu).

So while you may compose your page entirely in Times (Netscape Composer’s default choice), if the
user has set the default font to Arial, Arial is what he or she will see. The only control you have
over the font is its size (relative to what the user has set as his or her “normal” size) and whether it is
bold or italic. [The only exception to this occurs when you set the font to “fixed width.” In this
case, the font is changed to whatever font the user has chosen (again under “Preferences”) for his or
her fixed-width font (usually Courier).]

Consequently, you cannot specify that the font be 18-point Times for example. What you can
specify is that it be whatever the user has set as the “Normal” font. Based on that, if you increase the
font’s size, it will be displayed larger than the user’s normal size, whatever that may be.

PRINT: Use this button to decrease the size of the selected text.

FIND: Use this button to find a word or words on the page.

INSERT LINK: Use this button to link the selected text or image to another location in the
same document (further down the page, for example) or to another document entirely (one of
your own creation or another page anywhere on the Web).

INSERT TARGET (Named Anchor): Use this button to insert a “target,” a location in
this document that users will jump to when they click on a link elsewhere in this document.

INSERT IMAGE: Use this button to insert a graphic image or picture into your page.

INSERT HORIZONTAL LINE: Use this button to insert a horizontal line or rule between
lines of text.

INSERT TABLE: Use this button to insert a table in your document (similar to a table in
Microsoft Word, for example).

CHECK SPELLING: Use this button to check the selected text on your page. If no text is
selected, the entire page is checked.
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Format Toolbar, continued

FONT SIZE: Use this button to change the size of the selected text.

FONT COLOR: Use this button to change the color of the selected text.

BOLD: Use this button to make the selected text bold.

ITALIC: Use this button to make the selected text italic.

UNDERLINE: Use this button to underline the selected text.

REMOVE ALL STYLES: Use this button to remove any styles (bold, italic, etc.) from the
selected text.

LISTS: Use these buttons to insert a bulleted or numbered list. The kind of bullets and
the kind of numbering can be changed by selecting the text and pulling down the
“Format” menu to “Character Info…,” and then clicking on the “Paragraph” tab in the
resulting dialog box.

INDENTS: Use these buttons to decrease or increase the amount of indent of the
given paragraph.

ALIGNMENT: Use this pull-down menu to change the alignment of the given paragraph
to either left aligned, centered, or right aligned.

PARAGRAPH STYLES: Netscape Composer and
the HTML language it uses have built into them a set

of paragraph styles for easily creating consistent body text, headings of several
sizes, lists (including bulleted and numbered lists), and a few others as well.
These are chosen from the pull-down menu in the Paragraph Format Toolbar.
To apply a paragraph format, make sure the flashing cursor is in the paragraph
you want, and then chose the formatting desired. Experiment with different
ones to achieve the look you want. All of the text in the paragraph will
change accordingly.
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Entering Your Text
Although Netscape Composer’s Editor is not a full-fledged word processor, you still enter text in
essentially the same way you do with a real word processor. As you type, do not insert a “Return” at
the end of a line unless you want to end the paragraph. Simply let the text wraparound from one
line to the next. That way, the text will be automatically re-sized to match the width of the user’s
window.

To change a block of text’s attributes, simply click-and-drag across it to select it, and then apply the
attribute desired. Once the text has been selected, you can either use the appropriate button for
bold, italic, etc., or you can pull down the “Format” menu to “Character Info”  to get a dialog box
enabling you to apply several attributes at once (including ones, such as blinking and superscript,
for which there are no buttons).

Saving Your Work
After you have been working for awhile, it is a good idea to save your work to either your computer’s
hard disk or to a floppy disk. Whichever one you use, you must save everything to the same
directory or folder in order to make the “publishing” process an easy one (“publishing” is detailed
later in this document). The saving process is identical to that used to save a word processing
document, for example. Simply click on the “Save” button, or pull down the “File” menu to “Save.”
In the standard dialog box that follows, find the directory or folder that you want (if you are
working in LY215, see Appendix C for additional information about saving). Although you may
eventually have many related Web pages on your site, one page will be your so-called “home page,”
the one that first greets visitors to your site. You must name this page as follows, all in lowercase
letters, exactly as shown:

home.html

Type this name into the “Save as” box, and then click “OK.” As you continue to work on your page,
you should continue to save it. Simply click on the “Save” button, and the page will continued to
be saved with this name and in the selected directory or folder. Additionally, any graphic images
you add will be automatically saved to this folder or directory as well. In short, if you get it right the
first time as described above, it will stay right from then on! If you add additional pages, you can
name them anything you like, but they must all end with the same  .html  as your home page (see
Appendix E for more information about UNIX file names).

Checking Your Progress
Since Netscape Composer’s Editor is not always exactly WYSIWYG, what you see on the screen is
not exactly how your page will look when it is published on the Web. However, at any point during

the page creation process, you can check how your page will eventually look. Simply click on
the “View in Navigator” button, and Netscape Navigator will open a new window showing
you how your final page will look. In this way you can discover any obvious errors, and check

that all of your links work (assuming that you have inserted any links—see following pages). Note
that you cannot go to the Browser until you have saved your document. If you haven’t saved it
recently, Netscape Composer will give you a friendly reminder. Simply click on “Save” to continue.

To go back to the Editor, simply close the Navigator window that just opened.
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Adding Rules
A built in feature of Netscape Composer is the ability to add horizontal lines (or rules)
between paragraphs. To add a horizontally line, make certain the flashing cursor is located

correctly, then click on the “Insert Horizontal Line” button. By default, a narrow, two-point, 3-D,
shaded line is inserted running nearly the entire width of the window.

Links & Targets
Whenever you click on a button or text on a Web page, and you are transported to another page,
you have followed a “link” to the new location. Such links can be made to your own Web pages or
to those of others. Normally when you click on a link, you are taken to the beginning or top of the
specified page. If you go directly to a specific location on a page, the location you go to is then
called a “target” (or anchor). You can go directly to a specific location on the same page or on a
different page. For example, if your Web page is very long, you could put a table of contents at the
top of the page with links to targets further down the page. In this manner, a user could go directly
to that section of your page without having to scroll there. Or you could have a separate page just
containing definitions, for example. On all your other pages, any time a defined word appears, you
could set up a link to its definition on your definition page. By having a target at each definition,
the user would be taken directly to that definition instead of to the beginning of the list.

Since true links require other pages, and targets can simply be to different locations on the same
page, targets are discussed here first. The following directions are for linking text. Graphic images
will be discussed later.

Targets

Inserting a target and making it active is a two-step process:

Step 1: First put the insertion point (the flashing cursor) at the location where you want the
user to jump to when he or she clicks on a link somewhere else on your page. Then click on

the “Insert Target” button in the Format toolbar. A dialog box should appear. Give the target a
name. Since this name will not appear anywhere
on your finished Web page (it is for internal
bookkeeping purposes only), you can name it
anything you like, but by giving it a meaningful
name, you will make it easier for you to pick it out
of a list later on in Step 2.

To change the appearance of a horizontal line,
double-click on it, and a dialog box should appear.
With this dialog box you can change the line’s
various attributes.

Note: The “Apply” button allows you to preview
your changes without closing the dialog box. 7
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Targets, continued

Step 2: Go the place in your document where you want a user to come from. Select the text
(by clicking-and-dragging across it) that the user will click to go to the target. Then click on
the “Insert Link” button. A dialog box should appear.

The text you selected
should appear in the
“Link Text” box at the
top of the dialog box.

In the “Link To”
scrolling list at the
bottom should be a list
of all the “named
targets” in your
document. Click on the
desired one, and its
name will appear in the
box above.

Click on “OK.” That’s
all there is to
establishing and linking
an anchor.

Links to Your Other Pages

The process for setting up a link to a different page (yours or someone else’s) is a simple one-step
process. Linking to your own pages is easy; linking to others’ pages is slightly more difficult. Of
course, before you can link to another one of your own pages, that page must first exist and should
be in the same folder on your hard disk as the current page.

Assuming that such a page exists, select the text that will establish the link, and click on the “Insert
Link” button as before. In the same dialog box that appears, click on the “Choose File…” button in
the “Link to” box. You will be greeted by the standard “Open File” dialog box. Find the page you
want, and click on “OK.” The name of the page, along with its complete path, will appear in the
“Link to” box. Click on “OK” again, and you’re done.
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Links to Others’ Pages

The process for linking to others’
pages in almost the same as above,
with one exception. Instead of
clicking on the “Choose File…”
button, you must enter the exact
URL (Uniform Resource Locator) for
the page to which you want to link.

A URL is a Web page’s address on the World Wide Web, and usually begins with “http://.” This is
the address that appears in the little “Location:” window at the top of the screen when using
Netscape Navigator. Some familiar URLs are

http://www.kutztown.edu
http://www.microsoft.com
http://www.whitehouse.gov

One way to enter a URL is to simply type it in. However, this method requires that you make
absolutely no mistakes: every punctuation mark and every letter must be correct (case matters). An
easier way to enter the correct URL is to actually go to the desired page and copy its URL
electronically. After going to the desired page, simply drag the cursor across the text in the little
“Location:” box, then copy the selected text to the Clipboard (“Copy” under the “Edit” menu).
Then open the “Make Link” dialog box as before, click in the “Link to” box, and insert the URL by
pasting the contents of the Clipboard (“Paste” under the “Edit” menu). Then click on “OK.”

Link to Your E-mail Mailbox

If you want to give users the opportunity to send e-mail directly to you when they are viewing your
Web page, you can insert a link directly to your e-mail mailbox. There is even a style—“Address”
on the paragraph style pull-down menu—specifically designed and universally recognized for e-mail
addresses. First type the text telling the user to click on to send you e-mail (something like “Click
here to send e-mail to this page’s creator”). Next select the text, and click on the “Make Link”
button as before. In the “Link to” box, enter the following:

mailto:your-e-mail-address

(where your actual e-mail address replaces “your-e-mail-address”). Note that “mailto” is one word,
followed by a colon, with no spaces, followed by your e-mail address, again with no spaces.

9



© 2002. R.S. Schaeffer Building Web Pages in Netscape Composer

Graphic Images
Although the World Wide Web is very text oriented, graphic images can be an integral part of a
Web page. You might want to include diagrams, illustrations, formulas, and photos, for example, to
help explain and elaborate on the contents of your page. Or you might want to add graphic images
just for the aesthetic appeal they provide by breaking up vast amounts of text. Graphic images can
be as simple as small, colored bullets and thin, horizontal lines (replacing the colorless ones built
into HTML), to full-color, large-size, high-resolution photographs.

There are numerous ways to acquire graphic images:
◆ Draw them yourself in a program such as Adobe Illustrator or Adobe Photoshop.
◆ Take them from CD-ROMs of clip art.
◆ Use a scanner or digital camera to input images to your hard disk.
◆ Use Equation Editor: see Appendix B
◆ Acquire images directly from any World Wide Web page.

For beginners, the easiest method is undoubtedly the last. You can capture for your use any graphic
image you see on any page on the Web. In fact, there are Web pages out there that consist entirely
of clip art designed specifically for use on Web pages (see Appendix A). Although copyright laws
still cover the contents of Web pages, most people who post images fully expect—and even invite—
you to “borrow” their images. Note, however, that some may require you to include a copyright
notice identifying the source of the image.

Creating Your Own Images

Although creating your own images is beyond the scope of this introductory lesson, there are a few
things to keep in mind if you have the program(s) and you choose to do so. There are only two
formats that can be used: GIF and JPEG. GIF is used for images consisting of areas of solid colors,
such as logos, buttons, and other simple graphic images. JPEG is used for photo-realistic images.
Also, since most browsers such as Netscape Navigator recognize only 256 colors for GIF images, you
should reduce your palette to 256 (or fewer) colors for GIF images to avoid unexpected results when
users view your page. JPEG images have no such restriction. Finally, since the image will be viewed
only on a computer screen, use a resolution of 72 pixels per inch.

Capturing an Image You See on the World Wide Web

To capture an image you see on a Web page, move the cursor over top
of the image, hold down the mouse button (the right mouse button on
a PC), and a menu should pop up. Since you need to save the image
onto your hard disk or floppy disk (and eventually onto your server),
you need to save the image. Move the cursor over “Save this Image
as…” and release the mouse button. You will be greeted by the usual
“Save” dialog box with the original name of the image already entered
for you. You can change the name if you want, but there are certain
rules you must follow (see Appendix E for more information about
UNIX file names). Make certain that you are saving to the same
location as your Web page, and then click “OK.” Note that if you
don’t save it to the proper directory or folder, any graphic image files
can be automatically copied to that directory or folder when you place
the image in your document (which means you will have two copies
of the graphic image file in two different locations).
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Inserting Graphic Images

To insert a graphic image on to your page (assuming that you have already acquired such an
image from one of the sources cited on the previous page), click on the “Insert Image” button.
A dialog box will appear. To select the desired image, click on the “Choose File…” button at

the upper right. You will be
presented with the standard
“Open” dialog box. Find the one
you want, and click on “Open.”

The “Alternative representations”
enable you to help users when
they view your page. More
advanced page designers may
want to specify a low-resolution
image as an alternative, one
which will load quickly until the
real image loads. For users who
have access only to a text
browser, the “Text” alternative
representation will tell them what
they are missing.

You can also specify how the
image will interact with the text

around it. Although the “Dimensions” box may initially register zeroes for the height and width,
you don’t have to fill them in—they will be filled in automatically when you click on “OK.” You
can also assign space around the image as well as a solid black border to the image. Note that if you
selected an image that was not in the same directory or folder as the page itself, you have the option
at the lower left to “Copy image to the document’s location.” Make sure this option is checked so
that the “publishing” process (described later in this document) is a painless one.

While this dialog box is open, you can also click on the “Link” tab to establish a link for the image
(described earlier in this document). You can also click on the “Paragraph” tab to set the image’s
horizontal alignment (left, center, or right) on the page. When you have everything set the way you
want, click on “OK.” The image should now appear on your page.

After you have placed the image, if you want to change any of its attributes, simply double-click on
it, and the above dialog box will once again appear.
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Changing the Appearance of Your Document
Once you have your Web page started, you can change its overall appearance. For example, you can
change the light gray background to a different color or a pattern. You can also change the color
used for text indicating links.

To change the appearance, pull down the “Format” menu to “Page Properties.” In the dialog box
that follows, click on the “Color and Background” tab. Click on the “Use Custom Colors” button to

access the things for which you can change the
color. If you pull down the “Netscape Default
Colors” menu, you can try some different color
combinations that Netscape Communicator
suggests. After selecting one from the menu,
click on the “Apply” button at the bottom of the
dialog box to see what it will look like. You can
then repeat the procedure for another
combination.

To try your own colors, click on one of the small
color rectangles, and pick a color from the
palette (or color wheel) that appears.

To change the background to a pattern, texture,
or other image, click on the “Page Background”

“Image” box and then the “Choose File…” button. In the standard “Open” dialog box that follows,
choose the graphic image file you want to use (you have to have previously obtained this image in
the correct format, and it must be in the same directory or folder as everything else on your page).
Regardless of its size, the image you choose will repeated and “tiled” to cover the entire window. You
can use any image you want, but remember that text will be overlaid on top of it. Simply try an
image to see its effect—you can then easily change it by repeating this procedure, or you can
remove the checkmark in the “Image” box to remove the background image entirely. If you stick to
subtle patterns and textures (available from some of the Web pages listed in Appendix B), you will
probably have the best results.

To change the name of your page (the name that
a user will see in the title bar of the window in
Netscape Navigator), click on the “General” tab
in the same “Page Properties” dialog box as
above. Enter the title in the “Title” box. Unlike
the name of the file you saved to disk (probably
“home.html”), this name can be more
meaningful and have spaces and other
punctuation.

You may also fill in the other boxes as well if you
like (don’t change the information in the
“Location” box however). This information is
used by search engines such as Yahoo! and
Infoseek to index your page.
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Working with Tables
If you have ever used tables in Microsoft Word, then you are already familiar with the concept.
Using tables in Netscape Composer allows you to present data in tabular form, with or without
borders between the cells of the table. It also allows you to present your information (text and/or

graphic images) in
a more attractive
and potentially
more readable
format. By using a
table without
borders, you can
design a page
similar to the one
shown here from
Kutztown
University.
Borderless tables
allow you to have
multi-column
text, for example.
Tables also allow
you to intersperse
text and graphic
images
horizontally across
the page.

Learning how to work with tables is as much an art as it is a science. You can format each cell
individually, have cells span several columns and/or rows, change the background color for
individual cells, fix the width and/or height of individual cells, or even have a another table within
a table cell. Detailed instructions for working with tables are beyond the scope of this document.
However, there is on-line help available from within Netscape Composer. When you have the
“Insert Table” or “Format Table” dialog box open, there is a “Help” button at the bottom of the

window.

Creating a Table

To create a table, simply click on the “Insert
Table” button. In the dialog box that follows,
most of the options are self-explanatory.

Note that your choice for the border’s width applies to
the edges of all the cells. You can’t, for example, have a
heavy border around some cells but not others. If you
decide to use a borderless table to layout your page, you
will probably find it easier to give it borders with a one-
pixel width initially to help you see where the cells are.

13
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Creating a Table, continued

You can later easily remove the borders after you have placed your text and/or graphic images. After
you are finished working with your table, to remove the borders, make sure the cursor is flashing
anywhere in the table, and then pull down the “Format” menu to “Table Info,” and in the dialog
box that follows, type “0” [zero] pixels for the “Border line width.”

Unless you specify otherwise, the size of a cell is
dynamic. That is, the cell’s size, both its width
and height, will expand to accommodate the
text or graphic images that you place in the
cell. If you want a cell to be a fixed size, you
need to specify that size. With the cursor
flashing in the cell whose size you want to fix,
pull down the “Format” menu to “Table Info,”
and in the dialog box that follows, click on the
“Cell” tab. In addition to being able to set the
cell’s “Text Alignment,” you can also specify its
width and minimum height at the bottom of
the dialog box. When you click in the check
box in front of “Cell width,” you are given the
choice of specifying the cell’s width as an
absolute by entering the width in pixels (there
are 72 pixels to the inch), or by specifying it as
a percent of the width of the entire table. It is
in this box that you can also specify the
background color for the cell.

Unfortunately, you must repeat this process for each individual cell. There is no way to
automatically give all the cells the same specifications at the same time.

There are also commands on the “Edit” and “Insert” menus for deleting and inserting rows,
columns, and cells. To delete an individual row, column, or cell, make sure the flashing cursor is in
the appropriate row, column, or cell, and then pull down the “Edit” menu to “Delete Table,” and
make the appropriate choice from the submenu. To add an additional row, column, or cell, make
sure the flashing cursor is in the row, column, or cell that you want to add another row below,
another column to the right of, or another cell to the right of, and then pull down the “Insert”
menu to “Table,” and make the appropriate choice from the submenu.

As has been previously noted, working with tables requires skill and patience. Experience and
experimentation are the best teachers. And don’t forget the “Help” button at the bottom of the
“Format Table” dialog box.
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“Publishing” Your Page(s)
Up until now, you have been saving everything to your hard disk (or floppy disk). In order to share
your Web page with the entire world, you must “publish” it. That is, you must place all your page(s)
and any related images on a mainframe file server via a process called “uploading.” Fortunately, if
you have been following the directions so far,
and have been saving all your files into the
same directory or folder, then you can use
Netscape Composer to upload all your files
easily and painlessly.

❶ Click on the “Publish” button (or
pull down the “File” menu to
“Publish…”).

❷ In the dialog box that follows, click on
the “All files in document’s folder”
button.

❸ Click on the “Select All” button.

❹ Depending on whether you are a student
or a faculty member, type the following into the “Publishing location” box (where “yourlogin” is
replaced by your actual login on the UNIX server and you don’t type “STUDENT:” or
“FACULTY:”):

STUDENT: ftp://ftp.kutztown.edu/www/student/yourlogin/filename.html
or

FACULTY: http://faculty.kutztown.edu/yourlogin/filename.html

❺ Type your login in the “User name:” box.

❻ Type your password in the “Password:” box.

❼ Click on “OK.”

If you followed the steps above correctly, all of your files should be automatically uploaded, one after
another. The name of each will flash on the screen momentarily as it is sent.

(NOTE: You may not quite be finished, however. You may still have to change the “permission” on
your files so that anyone can view them. Netscape Composer can’t help you with this task. You must
use the UNIX server. The directions for doing this are on the next page.)
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Changing the Permission & Group Ownership
(if necessary)

Now that your files are on the server, they must be made accessible to the rest of the world. This
should be done for you automatically, but on some isolated occasions, it is not. If you discover that
your pages are inaccessible, then you must change the “permission and group ownership” manually.
In order to this, you must first log onto the UNIX server directly (the same way you log on to read
your e-mail in “pine”). Note: If you are using the KU-Menu, type “q” to exit the menu and get the
so-called UNIX prompt (–>).

Changing the permission and group ownership is a three-step process. One-by-one, type each of the
following lines precisely (including spaces and asterisks), in the given order, with a “Return” after
each line (where “yourlogin” is replaced by your actual login on the UNIX server and you don’t type
“STUDENT:” or “FACULTY:”):

❶ STUDENT: cd /www/student/yourlogin
or

FACULTY: cd /www/faculty/yourlogin

❷ chmod 755 *

❸ chgrp web *

Your World Wide Web Address
Now that you’ve done all your hard work, it’s time to share your results with the rest of the world.
Your WWW address is as follows (where once again your actual login replaces “yourlogin”):

STUDENT: http://unixweb.kutztown.edu/~yourlogin
or

FACULTY: http://faculty.kutztown.edu/yourlogin

This address will take visitors to your home page (the one you named “home.html” when you saved
it). If you don’t have such a page, or you named it incorrectly, visitors will be greeted instead with
an index listing of all your files.

Where Do You Go From Here?
Now that you have at least one page, you can add others, all linked to your home page. If you want
to find out how to do fancier and more sophisticated pages, there are countless books available.
Unfortunately, they require that you either use a specialized program or that you play with the
actual HTML code. If you want to go that far, then you can download any page with an effect you
like and study its code to learn how to duplicate that effect on your page(s).
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Changing Your Web Site After You’ve Already Published It
A Web site or even a single page requires maintenance.
Information changes, your interests change, and links to
other’s pages becomes obsolete. Updating your site simply
requires that you go through the entire process all over
again. That is not as bad as it sounds at first. Since you
already have the page created, the majority of the work is
already done.

To update a page, you need to open the page in Netscape’s
Editor. If you have the page on disk (either your
computer’s hard disk or a floppy disk), pull down the “File”
menu to “Open Page in Composer…” to make your
changes.

If you don’t have the page saved to disk, then you need to
save it to disk before you can edit it. Open your page in Netscape Navigator by using your WWW
address. Pull down the “File” to “Edit,”  and you will be told that you have to save the document
before you can edit it. When you save it, the page and all its graphic images will be downloaded and
saved to the location you specify in the “Save” dialog box.

Whichever method you use, when you edit the page, you will be doing so to the one on your hard
disk or floppy disk. When you are finished editing and saving your work, you will have to upload it
again to the KU server (directions elsewhere in this document). If you haven’t changed the file
name, then the new version will automatically replace the one already on the server. Any new
graphic images will also be uploaded. You may also have to change the permission and group
ownership for any new files you upload (directions elsewhere in this document).

A Word of Caution about UNIX

UNIX (the language used on most servers) is very unforgiving. It doesn’t give you any second
chances. Depending on what you are doing at the time, this can be a blessing or a curse. When you
upload a file, if a file by that name already exists in the directory you are uploading to, the new one
automatically replaces the old one. You are not warned; you are not asked if you want to replace the
old with the new. This is exactly what you want to happen when you upload an edited page and its
graphic images. If your page contains ten graphic images, you don’t really want to be asked if you
want to replace the old with the new eleven time (once for the page itself and once for each of the
ten graphic images). You want editing an existing page to be quick and easy.

If however, you have created a new page to add to your site, you must be certain that the name of
that page and any new graphic images on that page don’t have the same names as any items already
on the server. For example, if you create a new page and it has a graphic image named
“New_Button,” and an existing page also has a different graphic image also named “New_Button”
(because you created the old page awhile ago, you simply forgot the names of all the graphic
images), when you upload the new page, the new “New_Button” will automatically replace the old
one without warning. This is not what you wanted to happen. Now your old page will display the
new “New_Button,” instead of the original one. The moral of the story is that you need to know the
names of all your files already on the server. To see such list, refer to Appendix D.
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Glossary
browser A program, such as Netscape Navigator or Internet Explorer, used to

view Web pages.

FTP “File Transfer Protocol” is the method by which files (pages and graphic
images) are electronically transferred from one computer to another.

GIF “Graphics Interchange Format” is a universally-recognized format used
for graphic images. The GIF format is used for images that tend to have
large, flat areas of a few colors, such as you might find in a logo, a chart, or
a diagram.

HTML “HyperText Markup Language” is the computer programming language
that Web pages are actually written in. Netscape Navigator write this
code for you, so you never have to get your hands dirty.

JPEG “Joint Photographics Expert Group” is a universally-recognized format
used for graphic images. The JPEG format is used for images that tend to
be photo-realistic.

link A piece of text or a graphic image that can be clicked on to take the user
to another Web page.

login The name you use to log on to KU’s UNIX server (for a student, a typical
login follows the format “abcd1234” and for a faculty member, the first
eight letters of your last name).

pine The old e-mail program on KU’s server.

pixel A screen “dot.” There are 72 pixels per inch.

publish To make your Web page accessible to the entire world by uploading it to
a server.

server A mainframe computer where Web pages reside.

UNIX A language used to communicate with a server.

upload To electronically transfer your Web pages and/or graphic images from
your computer to the server, usually using a process called FTPing.

Web See World Wide Web.

WWW “World Wide Web” (or simply the “Web”) is a collection of servers, such
as the one at KU, all linked together electronically and used for sharing
information

WYSIWYG “What You See Is What You Get” is an expression that means what you
see while you are working on a document is exactly what you will get
when you publish the document. Netscape Composer is almost, but not
quite, WYSIWYG.
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Appendix A
Finding Graphic Images on the Web

The following sites are good beginning sources for graphic images. Most of them have links to other
clip art sites. If you are looking for a particular image, you might also want to try any of the large
search engines such as AltaVista (http://www.altavista.com/), HotBot (http://
hotbot.lycos.com/), or InfoSeek (http://infoseek.go.com/), since all of these search
engines allow you to indicate that you are looking for images.

http://www.kutztown.edu/icons/home.html

http://dir.yahoo.com/computers_and_internet/graphics/clip_art/
index.html

http://www.barrysclipart.com/

http://webclipart.miningco.com/

http://www.geocities.com/ginis/

http://www-ns.rutgers.edu/doc-images/

http://www.cit.gu.edu.au/~anthony/icons/

http://www.di.unipi.it/iconbrowser/icons.html

http://www.animfactory.com/

http://www.clipartconnection.com/
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Appendix B
Equation Editor Equations

Although you can’t save an equation in Equation Editor, you can use Microsoft Word to save it for
you. After creating an equation in Equation Editor, place it into a blank Word document in the
usual manner. Then pull down the “File” menu to “Save as HTML.” You will be prompted for a
name for the Word document. You can name it anything you like since you will be trashing it later
anyway. When you save a document as HTML, Word automatically saves each graphic image in the
document (and an equation is considered a graphic image) as a separate GIF file in the same
directory or folder that you saved the document itself in (which for our purposes here should be the
same directory or folder in which you are saving your Web page). Word simply names this graphic
image file as “Image1.gif.” If you know how, you can change this name to a more meaningful one
before you place it on your Web page, but you don’t have to.

If you place several equations into a Word document before you save it as an HTML file, then each
one will be converted into a GIF file when you save: “Image1.gif,” Image2.gif,” “Image3.gif,” etc.
Again, you can change these names to more meaningful ones.

At this point, you can delete the document itself since each of the equations is now an independent
graphic image file. To place an equation in your Netscape Composer document, follow the
directions for placing graphic images elsewhere in this document. You don’t have to worry about
putting the graphic images in the same directory or folder as the Netscape Composer document—
when you save that document, any graphic image files are automatically copied to that directory or
folder.

20



© 2002. R.S. Schaeffer Building Web Pages in Netscape Composer

Appendix C
Saving in LY215

If you do not have an individual account (in your name) in LY 215, then it is strongly suggested that
you do not save your work on the server or on any individual hard disk in that room. Class accounts
are open to anyone with the class’s login and password; and hence, anything saved under that
account can be viewed and changed by anyone with that class’s access. Additionally, at the end of
each semester, all class accounts will be deleted.

You should save all of your work to a floppy disk, so that you can take everything with you when you
leave the lab. If you “publish” your pages, however, all of the published files will be automatically
uploaded to the KU server. When you then go to edit your pages in Netscape Composer on any
other computer, anywhere in the world, Netscape Composer will have you automatically download
and save all of your files anyway to the computer you are then using.
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Appendix D
Viewing a List of Your Files on the KU Server

To see a list of all the files (pages and graphic images) on your KU Web site, you need to log on to
the UNIX server (the one used to read e-mail in “pine”). Getting such a list is a two-step process.
You must first tell the server to change the directory to the one containing your Web files, and then
tell the server to produce a list of those files.

After you have logged on to the UNIX server (enter “q” if you are using the KU-Menu), enter the
following lines precisely (where “yourlogin” is replaced by your actual login on the UNIX server and
you don’t type “STUDENT:” or “FACULTY:”):

❶ STUDENT: cd /www/student/yourlogin
or

FACULTY: cd /www/faculty/yourlogin

❷ ls
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Appendix E
UNIX File Names

UNIX file names are usually constructed using letters, numbers, and a few other special characters.
Since many of the other characters have special meanings in UNIX, it is strongly suggested that you
restrict these other characters to the dot (.), the minus or dash (–), and the underline (_). In
particular, don’t use a colon (:), a space ( ), a slash (/), or an asterisk (*). Additionally, do not begin
a file name with a minus. You may use a combination of lowercase and uppercase letters, but UNIX
is case-specific. That is, “Junk” is a different file name from “junk” and “JUNK.”

If you are using a PC, the operating system (Windows 98, for example) may automatically add a so-
called “extension” (a dot followed by three letters indicating the type of file) to some files. Such
extensions have no special meaning in UNIX, but they do in the PC’s operating system, so it is
suggested that you leave them as they are. Additionally, such extensions (“.gif,” for example) can
help you remember the significance of particular files after you haven’t seen their names in awhile.
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